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I’ve only ever lived in the U.S., so aside from hearing others who live in other
parts of the world talk, I don’t have much frame of reference for how “things are”
outside of my native country. And, as someone who is still considered “middle
class,” I don’t have the opportunity to travel to the far flung, distant places that I
would love to be able to travel to. As such, I apologize in advance that this
month’s column is going to be rather U.S.-centric.

One of my absolute favorite “personalities” is a guy that you all have most likely
watched. He is Mike Rowe, and the host of Discovery channel’s hit show, Dirty
Jobs. If you’re not familiar with him, click on the previous link to bring up some
interesting non-Dirty-Jobs appearances that are on YouTube, including a talk he
gave for TED.

Rowe’s time on Dirty Jobs illustrated a real disconnect in the American education
system, and in America as a whole, and he set out to try to do something about it.

Back in the 1950s through the 1980s, American high schools typically embraced
academics and vocational training. Somewhere along that journey, someone
thought it would be a good idea that ALL students strive to attend college for a
traditional four-year degree. As a result, most high school home economics
(cooking) classes, along with auto mechanics, carpentry, metalworking, and other
vocational training classes were axed.

The end result is/was multifaceted, and not entirely the “good results” that were
sought. College students graduating today face ENORMOUS debt directly
caused by that college education. The cost of a college education has risen in the
U.S. at a rate that outpaces even the costs of health care. College graduates,
collectively, face $1.5 trillion (U.S.) of debt. Meanwhile, there are OVER 7 million
skilled job openings that cannot be filled, simply because there is no one with the
skills to fill those jobs.

Most of these jobs are the types of things that were previously taught in high
school vocational education programs … you know, the ones that they did away
with. These include diesel mechanics, auto mechanics, carpenters, plumbers,
electricians, aircraft mechanics, heavy equipment operators, and other skilled
labor jobs.

Meanwhile, many of the college graduates … the ones who are now impacted by
a HUGE debt for that college education … are now either unemployed, under-
employed, or working at jobs that have absolutely NOTHING to do with their
college education. Sometimes, that situation is understandable. I mean, what can
you expect to be able to do with a degree in medieval textiles? The same goes
for a gazillion other “professions” with limited marketability or demand.

But not everyone needs to be a doctor, or a lawyer, or an engineer, or a teacher,
or an accountant. MBAs are a dime-a-dozen these days. Sometimes, you need
someone who can pave the roads, build the houses, wire and plumb those
houses, landscape the yards, unclog the toilet, build bridges, fix our vehicles, etc.
And, because of the push in American education towards EVERYONE getting a
college education, we have a surplus of the former, and a serious drought of
those trained to do the latter.

So, remember I said Rowe set out to do something about that disconnect? Well,
in 2008, he founded the Mike Rowe WORKS Foundation to push for training for
skilled labor jobs. You can read more about his foundation here. He even has a
listing of skilled labor job openings on his foundation website here.

From The Chief Editor's Desk ...
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I can remember when I was headed into what we
then called “junior high school.” I was so excited to
have a “shop class.” There, I made a wooden cutout
of a fish, where I learned how to use a bandsaw, a
scroll saw, and a coping saw. I made a metal planter,
where I learned how to cut metal, spot weld that
metal, solder that metal, and paint that metal. We
constructed small kit motors, so we could learn the
basics of how electric motors worked. The next year,
we had “construction” shop class, where we built –
from scratch, with raw materials – a scaled down
corner of a house, complete with wiring, plumbing,
insulation, a window, and roofing.

I didn’t pursue it much further after that, but coupled
with what all I did around my childhood house to
help my father with projects, I ended up with a pretty
solid foundation for the “labor” type jobs. I would be
right at my father’s side whenever there was a
project that had to be completed. That included
working on the car, home repairs, home remodeling,
making a dog house, repairing and maintaining the
lawn mower, and many other “projects” that
happened along. I ended up taking a more academic
path and going to college (I was the first in my family
to EVER get a four-year college degree), while
several of my classmates pursued a vocational path.

But, still to this day, those “skills” serve me well. I do
as many of my own home repairs and maintenance
as I’m able (but I HATE plumbing!). I maintain my
own lawn mowers and yard equipment. I’ve built my
own chicken coop and run. And, doing these tasks
or projects myself is DEEPLY rewarding and
satisfying.

Readers of my monthly “From The Chief Editor’s
Desk …” column will have seen pictures of me with
my kids on a regular basis. As a parent, I think it’s
fairly natural to look at your kids and imagine what
path their lives might take. For Ryan, I can see him
equally happy in either a skilled job or in one driven
more by academics. For Lexi, I can see her finding
happiness in more academic roles. They are both
right at dad’s side whenever I have a project around

the house, and I try my hardest to pass on to my
kids that passion for the skilled, manual labor tasks
that I undertake.

Mike Rowe is on to something, I believe. There are
good, well paying jobs available for those with the
skills and desire to do them. And, they don’t require
a college education to do them. Gaining employment
in one of those “manual trades” will enable a fulfilled
life, with decent pay. A job is, after all, a means to an
end.

**********

This month’s cover image is by Photo Mix from
Pixabay.

**********

Until next month, I bid you peace, happiness,
serenity and prosperity … and continued good
health!

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

From The Chief Editor's Desk ...

mailto:pclinuxos.mag@gmail.com
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by Paul Arnote (parnote)

Hey. Everyone likes to get something for free. So put your wallets and credit
cards away. The internet is chock full of freebies, if you only know where to look.

Free Books/Ebooks

If you like to read (and I hope you
do), you have a deep well of
material to wade through with free
books to read. And no, I’m not
talking about heading down to the
local branch of your library. These
books are available, for free, from
various sources on the internet.

I’ll spend the majority of my time
covering sources that allow users
to actually download the files to
their computer, instead of
requiring you to view the ebooks
on a mobile device or dedicated
ebook reader. If you have a
mobile device or a dedicated
ebook reader, don’t discount
using it to access free ebook
content. But don’t expect to be
able to download free ebook
content from your local library,
Amazon, Barnes & Noble, Kobo,
Google or Apple to your
computer, thanks to paranoia
from book publishers and the
imposition of DRM (digital rights

management) techniques that, at best, are difficult (if not impossible) to thwart or
overcome.

Project Gutenberg is probably one of the best and oldest resources on the
internet for getting free books in a variety of file formats. Founded in 1971,
Project Gutenberg offers over 60,000 free ebooks. Relying mostly on the efforts
of volunteers to bring written material into formats more widely accessible by
users of modern technology, Project Gutenberg gets its name from the inventor
who is widely accepted as the inventor of the modern printing press.

Project Gutenberg offers
multiple formats for
bookworms to download
files in. They include
HTML (which you can
read in any browser),
EPUB (with and without
images), MOBI (with and
without images), or plain
text files. The plain text
files are Project
Gutenberg’s mainstay,
with a firmly entrenched
belief that the plain text
format will be readable
far, far into the future.
Users can further
customize formats by
loading the plain text file
into a word processor
(such as LibreOffice Writer) and then exporting the book to a PDF file, or convert
it to any other format you prefer with the multi-purpose Calibre ebook reader and
cataloger.

Despite its reputation as the go-to place to find literary classics, Project
Gutenberg is not the only place on the web to find free ebooks. Let’s take a look
at some of the other free ebook outlets out there.

ManyBooks.net is another ebook site that features over 50,000 ebooks, most of
which are available for free. Those that aren’t free are available at a very
inexpensive cost. ManyBooks features all of the file formats that Project
Gutenberg offers, plus PDF, Azw3, Fb2, PDB, and RTF file formats.

Free-bruary: Free (Or Almost Free) Stuff For You

https://www.gutenberg.org/
https://manybooks.net/
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Free-eBooks.net is one that I personally have mixed feelings about. I used to
“belong” to their website years ago, but unsubscribed for a couple of different
reasons. First, they sent way too many emails. Second, unless you were a paying
subscriber, you could only download ebooks in plain text format. EPUB and/or
MOBI file formats were reserved only for paying subscribers. Yes, you can get
some decent, free ebooks from here. Downloading only plain text files, you will
have to use something like Calibre to convert the plain text files to other ebook
formats. However, no one can download anything without signing up for an
account, which will restart the barrage of endless emails clogging up your inbox.
Personally, I’m too afraid of the endless emails part to sign up again to see
whether or not they have changed their practices.

Bookyards is a relatively newer site that I had not heard of before. They have
over 24,000 free ebooks available. The site is very easy to navigate, and only five
books are presented at a time for you to choose from when viewing their catalog.
Their mission is “to provide the same information and content that one can
receive at any large public library, and to provide it through the world wide web.”

Obooko is also a new find for me. All of the books on the site are free, and you
can choose if you want to download the books as PDF, EPUB or MOBI files
(choices may vary some by individual titles). You will, however, have to register
an account to be able to download anything.

Loyal Books is another site that allows free downloads of public domain ebooks.
When you go to their homepage, you might think that they only offer audiobooks.
But select a category you want to explore, and drop the list down at the top of the
page to show ebooks. They offer books in plain text (TXT), EPUB, MOBI and
HTML formats for download.

If you have a library card from a participating local library, you can access even
more free ebooks at OverDrive, and Hoopla Digital. The only bad thing that I’ve
found is that there doesn’t seem to be any way to view/download the ebooks on
your home computer running PCLinuxOS. You can, however, view them to your
heart’s content on your mobile device or dedicated ebook reader.

I’m sure you can find other outlets for free and almost-free ebooks. These should
get anyone started with plenty of selections to choose from. Just the 110,000+
ebooks available from Project Gutenberg and ManyBooks should prove to be a
daunting task for even the most voracious reader to work their way through.

Free Audio Books

If you prefer your books in
audiobook form, you’re in
luck. There are a number of
sites offering up free
audiobooks that you can
listen to on your personal
audio player, on your phone
or other mobile device, or
playback in your car. The
audiobooks are available
mostly as zipped MP3 files,
with one MP3 file for each
chapter. If the audiobooks
are not zipped into a
package, you will have to
be careful to download each
part of the book manually,
and carefully save it with
the other parts of the same
book.

It would be a trivial task to burn multiple books to a CD (each book’s audio files
appear to typically be less than 200MiB, so you should get three or four books on
a 700MiB CD), with all the MP3 files for each book in their own folder, and them
play them back in your car over its stereo, especially if your car’s CD player plays
MP3 CDs. Some newer cars even have a USB port, where the stereo will read
files from a USB flash drive. Most USB flash drives have capacities far greater
than the 700MiB capacity of a CD, increasing the number of audiobooks you can
put on there immensely.

LibriVox is probably one of the premiere sites to download free audiobooks. They
have entered a partnership with Project Gutenberg to produce free audiobooks of
public domain content. As far as I can tell, all of the audiobook files are multi-part
MP3 files, one MP3 file per book chapter, presented in a ZIP file archive. They
currently have more than 10,000 audiobook files available, totally for free.

Loyal Books is another site that offers free audiobooks. You can download each
individual chapter of a book as its own MP3 file, or you can download a zip file of
all the chapters, with each chapter in its own MP3 file. You might have to look
around on the download page to find the download link for the zip file, but it is
there.

Free-bruary: Free (Or Almost Free) Stuff For You

http://www.linuxforums.org/forum/
https://www.free-ebooks.net/
https://www.bookyards.com/en
https://www.obooko.com/
http://www.loyalbooks.com/
https://www.overdrive.com/
https://www.hoopladigital.com/
https://librivox.org/
http://www.loyalbooks.com/
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Open Culture mostly serves as a “link farm” that connects visitors to the site with
the material they are looking for. So, while they don’t have anything original
themselves, they do help take some of the trouble finding files away by grouping
a list of available resources all together. They claim to provide links to 1,000
audiobooks.

The Lit2Go site offers up a significant number of audiobooks available for
download to your computer. Each chapter of each book must be downloaded
individually as a MP3 file. So, in the case of “The Adventures of Huckleberry
Finn,” you will have to download 43 different MP3 files, one for each chapter in
the book.

Free Print Magazines

No, we’re not talking about ezines/emags like The PCLinuxOS Magazine, or any
number of other similar magazines. We’re talking about the more traditional print
magazines. You know, like the ones you grew up with. Plus, it’s kind of nice to get
something in your snail mail mailbox besides bills, especially when it’s something
you’re interested in. Some of the free magazine subscriptions are only for the
digital version of the magazine, but contains the same content as the print
version.

You might be surprised by the premiere print magazines you can get for free. I
know that I was quite surprised by what I found on the list. But before we get to
which ones you can get for free, let’s talk about some things to beware of.

First of all, to get these magazines for free, you will typically have to complete a
survey and give up some of your personal information. Much of what they ask for
can be found easily enough, like your address, age, gender, email address, etc.
As such, you might prepare yourself for at least a slight increase in email (unless
you use a disposable email address). With some, the more surveys you
complete, the more magazines you qualify to receive for free.

Second, if they make “special offers” to you during the course of the survey, skip
them (unless you REALLY want them). Rejecting them typically does NOT affect
your ability to receive the magazine(s) for free.

Third, if they ask for any credit card information, skip getting that magazine. They
may be looking to charge your credit card to keep your subscription going after
your free subscription expires. Just move along to another magazine that piques
your interest.

So, exactly what magazines can you expect to find that you can get free
subscriptions to? Below is a list that is current as of the time that I wrote this
article. Keep in mind that the available magazines change from time to time, so
some of these may or may not be available by the time this article is published.

The first place to look is at Today’s Rewards. You will have to register for a free
account, but then you earn “points” for each survey question asked. When you
have enough points, you can “cash in your points” for free digital magazine
subscriptions.

Free-bruary: Free (Or Almost Free) Stuff For You

https://www.openculture.com/
https://etc.usf.edu/lit2go/books/
https://www.todays-rewards.com/
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Here is the list of magazines on the list: Bicycling, Cosmopolitan, Elle, Esquire,
Good Housekeeping, HGTV Magazine, Marie Claire, Road & Track, Town &
Country, Woman's Day, Food Network Magazine, Car & Driver, House Beautiful,
Men’s Health, Women’s Health, Prevention, O The Oprah Magazine, Country
Living, Harper’s Bazaar, Popular Mechanics, Redbook, Elle Decor, Runner’s
World, and Veranda.

Most all of the magazines “cost” 10 reward points, and are for a free one year
digital subscription to your chosen magazine(s).

Reward Survey also uses a rewards points approach to allow you to choose
which magazines you’d like to receive. The difference is that users are given 30
reward points to use towards redemption on the magazines just as soon as they
sign up. Most magazines are available for a one year subscription for redemption
of 10 reward points. Some magazines, like Cigar Aficionado and Wine Spectator,
are available for a one year subscription for redemption of 20 reward points. It is
unclear from reading the website and/or the offer whether the magazines you
receive are actual paper copies via snail mail, or if you get access to digital
copies emailed to you.

DealTrunk is another site that lists a LOT of free magazines that escape the net
cast by the other two previously mentioned sites/offers. It works just like the
previous two sites, where you provide your information, complete some surveys,
and then are rewarded with a free subscription to your chosen magazine(s) (you
can choose up to three magazines). Just as with the aforementioned “Reward
Survey” site, it’s unclear if you will receive an actual paper copy of the magazine
via snail mail, or if you gain access via digital copies emailed to you.

Here are the magazines that are available at the DealTrunk site, as of the time
that I am writing this article. Keep in mind that the free subscription offers may
end at any time, and they change from time to time. Also, read through the list
carefully, because they are not presented in any particular order.

Parents: complimentary two year subscription.

Esquire: complimentary one year subscription.

C California Style: complimentary one year subscription.

Town and Country: complimentary one year subscription.

DuJour: complimentary subscription, length unspecified.

Home & Lands: complimentary subscription, length unspecified.

This Old House: one free magazine issue.

Traditional Home: complimentary two year subscription.

Elle Decor: complimentary one year subscription.

Country Living: complimentary one year subscription.

Weight Watchers: complimentary one year subscription.

Men’s Health: complimentary one year subscription.

Rachel Ray Everyday: complimentary two year subscription.

Food Network: complimentary two year subscription.

Prepared Foods: complimentary subscription, unspecified length.

Whiskey Advocate: complimentary one year subscription.

Beverage Industry: complimentary subscription, unspecified length.

Wired: one free complimentary issue.

CNET: complimentary one year subscription.

Rider: complimentary one year subscription.

Subaru Drive & Performance: complimentary subscription, unspecified length.

Digital Photo Pro: complimentary one year subscription.

Outdoor Photographer: complimentary one year subscription.

Lego Life: free magazine for children, covering all things Legos.

Clay Times: complimentary free issue.

People Magazine: complimentary one year subscription.

Fast Company: complimentary one year subscription.

Entrepreneur: complimentary one year subscription.

Money: complimentary two year subscription.

Free-bruary: Free (Or Almost Free) Stuff For You

https://rewardsurvey.com/Express/ImpactExpress?impact-click-id=VmzXAo10MxyLWxNwUx0Mo3bOUkEyKhWLVSPgTM0&sfn=&sln=&email=&sa1=&sa2=&sc=&sz=&ss=&impact-partner-name=&irgwc=1&utm_source=impact&utm_medium=22640&utm_campaign=RewardSurvey%20Evergreen%20%2430%20Instant%20Reward
https://dealtrunk.com/free-magazines/
http://cdn.mercurymagazines.com/121-121000633/index.html
http://cdn.mercurymagazines.com/344-34402/index.html
https://shop.magazinec.com/request
http://cdn.mercurymagazines.com/121-12197710/index.html
https://www.ezsubscription.com/duj/subscribe?type=demo
https://www.homesandland.com/Order-Homes-Magazine.html
http://cdn.mercurymagazines.com/121-12167521/index.html
http://cdn.mercurymagazines.com/121-12198573/index.html
http://cdn.mercurymagazines.com/121-12198132/index.html
http://cdn.mercurymagazines.com/121-12197854/index.html
http://cdn.mercurymagazines.com/256-256235/index.html
http://cdn.mercurymagazines.com/121-121000615/index.html
http://cdn.mercurymagazines.com/121-121000002/index.html
http://cdn.mercurymagazines.com/121-121000536/index.html
https://freebizmag.tradepub.com/free-offer/prepared-foods/pf?sr=hm&_t=hm
http://cdn.mercurymagazines.com/121-121000649/index.html?
https://freebizmag.tradepub.com/free/bevi/prgm.cgi?a=1
http://cdn.mercurymagazines.com/121-1213011/index.html
http://cdn.mercurymagazines.com/121-12198489/index.html
http://cdn.mercurymagazines.com/121-12198213/index.html
https://subarudrive.com/magazines#subscribe
http://cdn.mercurymagazines.com/121-12198560/index.html
http://cdn.mercurymagazines.com/121-12196710/index.html
https://www.lego.com/en-us/life/magazine
https://www.surveymonkey.com/r/3M6N26F?sm=9kW0PGbFQSiKJa5AnyNuyA%3d%3d
https://cdn.mercurymagazines.com/304-304222/index.html
http://cdn.mercurymagazines.com/121-12198161/index.html
http://cdn.mercurymagazines.com/121-12197238/index.html?
http://cdn.mercurymagazines.com/121-12198584/index.html
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Time: complimentary subscription, unspecified length.

Fortune: complimentary two year subscription.

Travel + Leisure: complimentary subscription, unspecified length.

National Geographic: complimentary free issue.

There should be something in the above list that appeals to the interests of most
people.

Free Movies & TV Shows

I know we’ve covered free movie and TV show streaming in the past. Most of the
time, we’ve published articles on individual streaming options. But, to be honest, I
don’t know that we’ve presented free movie and TV show streaming options all
together before. So, let’s rectify that now.

Be forewarned that streaming a lot of movies and/or TV shows will consume a
considerable chunk of data. So, if you’re on a metered internet plan, have modest
data caps, or if you don’t have a reasonably fast internet connection, you may be
rather limited on how well streaming will work out for you.

Pluto TV is, by far, one of the free
streaming sites with the most to offer.
To start with, it presents streaming Live
TV, featuring many channels (hundreds
by their count). There are dedicated
Star Trek channels, an AMC channel, a
MST3K channel, a SciFi channel,
multiple comedy channels, multiple
movie channels, a military channel, a
documentary channel, children’s
channels (including my daughter’s
favorite, Dora TV, featuring non-stop,
24 hours a day streaming of Dora The
Explorer), news channels, and way
more than we can list here. Do you like
Westerns? You will certainly find a Live

TV stream to keep you coming back for more. Do you like game shows? There’s
a channel for you. Pluto TV has just about anything for just about everyone. We
originally covered Pluto TV in the August 2019 issue of The PCLinuxOS
Magazine.

But wait! There’s more! Pluto TV also features 1000s of On Demand movies.
While most are not “first run” movies, there is something for everyone. If you can’t
find a movie you want to watch, then you’re WAY too picky or way too hard to
please. The movies are divided up into many, many categories (by my estimate,
over 100 different categories), so you don’t have to wade through all the movies
to find the movie genre that you are interested in. There are kids movies, family
movies, horror movies, sci fi movies, adventure movies, drama movies, comedy
movies, military/war movies, western movies, concert movies, romance movies,
documentary movies, and many, many more categories than I can (or will) list
here.

You can watch shows on Pluto TV without signing in, or without creating an
account. However, both options are available, if you choose. There is a Pluto TV
app for both Android and iOS, enabling you to watch Pluto TV on your mobile
devices, and streaming Pluto TV content is an option on my SmartTV in my living
room. Of course, you can also watch it in your browser (Firefox or Chrome for
sure, but YMMV with other browsers) on your PCLinuxOS desktop.
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TubiTV is another excellent source for
streaming movies and TV shows for
free. Owned by Fox Corporation,
TubiTV is supported by ads. So, do
expect to see some ads inserted into
the movies and shows you choose to
watch. However, those ads are
typically less intrusive (lengthwise)
than what you experience with over-
the-air broadcasts. We originally
covered TubiTV in the May 2016
issue of The PCLinuxOS Magazine.

Just as with Pluto TV, you can view
the TubiTV content without creating
an account, and without logging in.

There is an advantage, however, of creating an account and logging in under that
account. When you find something on TubiTV that you want to watch (but maybe
you don’t have time at the moment to watch it), you can add that content to your
watch list, called My List.

Some of the categories that you’ll find TubiTV content under are Recently Added,
Black Cinema, Most Popular, Family Movies, Documentary, Horror, Action,
Something Completely Different, Movie Night, Comedy, Faith, Sci Fi & Fantasy,
New Releases, Romance, Westerns, Standup Comedy, Leaving Soon, Award
Winners & Nominees, Thrillers, Preschool, Martial Arts, Kids Shows, Classics,
Not On Netflix, Trending Now, and many, many more.

If you add content to your “My List” of things you want to watch, don’t take too
long to get around to watching it/them. Content comes and goes from TubiTV
fairly regularly, so if you wait too long, items in your list may not be available for
you to watch. Did you notice the “Recently Added” and “Leaving Soon” categories
above? There’s a reason for those.

Vudu is that place where you get your “free” digital copy when you buy a movie or
TV shows on DVD or BluRay. If you buy movies or TV shows on optical media,
you have probably seen the slips of paper inserted into the packaging with a code
to input on the Vudu site to secure/procure your digital copy. We originally
covered Vudu in the January 2019 issue of The PCLinuxOS Magazine.

Well, Vudu also has a lot of free content. That content is supported by ads
inserted into the content stream. Like with TubiTV, the ads on Vudu are short and
rather unobtrusive. Unlike TubiTV, you will need to create an account or login to
view the content on Vudu, but registration is free.

Sadly, Vudu’s playback only works on Chrome (or Chrome based browsers).
Firefox will not playback the content from Vudu. As a diehard Firefox user who
also happens to absolutely abhor Chrome, this is disappointing. Once in Chrome,
however, playback is easy and smooth.

PopcornFlix is yet another free streaming site that has a lot of movies. No login or
registration is required. In fact, there is no place on the page to login or register.
While they definitely do not have anything that could be remotely considered a
“first run” movie, there are some gems in its collection.

Believe it or not, you do not have to have a Roku or be a Roku user to access
The Roku Channel. There, you will find a wide variety of TV shows and movies
for your streaming pleasure. There is a wide (some might say eclectic) mix of
movies and TV shows available to stream for free.

Sony Crackle is, as you might imagine, a streaming site from Sony. You will find a
wide assortment of movies and TV shows from Sony’s massive library of content,
including Crackle-only original programming.

Also, don’t overlook YouTube as a source of free movies and TV shows. While I
am fully aware of a lot of peoples’ desire to avoid anything to do with Google
(Google owns YouTube), there are a lot of free movies and TV shows on
YouTube. For example, I grew up watching the WWII TV show “Rat Patrol.” I can
find every Rat Patrol episode on YouTube, commercial/advertisement free. For
movies, type “free movies” into the YouTube search bar. There are a LOT of free
movies. Many are viewable without any interruptions from advertisements. Others
are listed as “Free With Ads,” which means exactly what it says. The stream of
such content will be periodically interrupted with pointless advertisements.
However, the advertisements are short in length. You may have to filter through a
lot of chaffe to find the gems, but your efforts will be well rewarded.[a]

There are more free streaming options out there, but these should get you well
on your way. You might also want to look at streaming options for your favorite
network(s). Recently, for example, we covered the new Comet SciFi TV channel,
and how to stream its content in your browser. We also covered how to play IPTV
on your PCLinuxOS desktop. Like I stated, there are many more options and
choices to tailor your streaming experience to something that suits you and your
tastes. For more ideas, check out our article “Cutting The Cord In 2019” in the
August 2019 issue of The PCLinuxOS Magazine.

Help PCLinuxOS Thrive & Survive
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Free Documentaries

If documentaries are your idea of entertainment (they are one of my favorites,
too), then you are in luck. There are two sites that offer all the documentaries you
could ever want. Documentary Heaven is the heavy hitter in this genre, with over
7.420 documentaries hosted on its site. I was even able to find one of my favorite
documentaries, “The Fires Of Kuwait,” about the Iraqi military’s “scorched Earth''
policy when they pulled out of Kuwait in the first Gulf War, setting all of the
Kuwaiti oil wells on fire and the monumental task of extinguishing those oil well
fires. I had only seen it once before, years ago (many years before Dr. Pimple
Popper and My 600 Lb Life ever came along), on the TLC cable network when
they actually aired informative and educational content.

If you can’t find a documentary you’re looking for on Documentary Heaven, you
might want to try looking on Documentary Storm. You’ll find over 870
documentaries hosted there. As far as I can tell, there is no duplication between
the two sites. One you might want to take a look at is a documentary from 2011,
called “The Space Shuttle,” narrated by William “Captain Kirk” Shatner. Or,
maybe you’re a beer aficionado who would love watching a documentary about
craft beers, called “Beer Culture.”

Learn Something New… For Free!

Believe it or not, you can take
some free online classes. Many of
these free classes are from top-
notch universities, such as
Harvard, Stanford and MIT. Class
Central is one such site, where
you can choose which topics you
are interested in, and then you
can take classes in that topic. Do
you want to learn the basics of
TCP/IP? Take the “Introduction To
TCP/IP” course from Yonsei
University via Coursera. It will
require one to two hours of your
time per week, over a five week

period. If you want to continue on and dig deeper into TCP/IP, take the “TCP/IP
and Advanced Topics” course from the University of Colorado, via Coursera. It
will require two to five hours of your time per week, over a five week period.

Khan Academy is a non-profit organization that provides educational content for a
wide age range of students. They have content for PreK children, elementary
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school aged children, high school students, and early college students. All
educational content is delivered, free of charge. This should be a handy site if
you need to brush up on your algebra or geometry, want to learn statistics or
more about economics or chemistry, or if you want to get a better grip on your
personal finances (yes, there’s a course for that). It could be especially useful if
you have a child, grandchild, niece, nephew, or stepchild that you are frequently
asked to assist with homework. There’s even a section to help prepare for the
SAT or LSAT exams.

There is a section on the website that is geared towards teachers, as well. So,
teachers can take the information from Khan Academy and incorporate it into
their classrooms and lesson plans. Users will have to register for a free account,
though. Of course, all of these lessons and courses are available 100% free of
charge for anyone who wants to access them.

If you ever wanted to
learn a new language,
then DuoLingo is the site
for you. You choose which
language you want to
learn … Spanish, French,
German, Italian,
Portuguese, Dutch,
Japanese, Arabic, Czech,
Welsh, Danish, Greek,
Finnish, Irish, Hebrew,
Hindi, Russian, Korean,
Polish, Swedish, or any of
many more languages …
including Klingon … and
follow the lessons on the
website. You will have to
register, but after you do,
you will be able to start
learning a new language
by spending just five
minutes per day on your
language lessons.

EdX is another site where you can find classes/courses for free. Offering over
3,000 different courses, there are some that you have to pay for and others that
are free. The link at the start of this paragraph points to the search for free
courses and programs. At the time that this article was being written, there were
62 free programs and 755 free courses available.

We can change that search, and just highlight courses pertaining to Linux. For
example, you can take the EdX and Linux Foundation course, “Introduction To
Linux,” for free. If you want/need a verified certificate for your occupational
growth, one is available for $169 (U.S.) after successful completion of the course.
Keep in mind that some Linux courses are fee-based, so not all of them are free.
There are 10 programs and 61 courses dedicated to Linux.

Although not a course, TED is another great site where you can learn something
new. Founded in 1984, you will find (mostly) relatively short talks covering a wide
variety of topics. Here’s the “About” definition of TED, straight from the TED
website:

“TED is a nonpartisan nonprofit devoted to spreading ideas, usually in the form of short,
powerful talks. TED began in 1984 as a conference where Technology, Entertainment and
Design converged, and today covers almost all topics — from science to business to
global issues — in more than 110 languages. Meanwhile, independently run TEDx events
help share ideas in communities around the world.”

If you’ve never watched a talk on TED, you are in for a treat. Some are quite
funny, some are quite emotional, others are quite informative, while others are
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quite sober. Some are all of those rolled into one. There are talks on TED to
cover virtually every and any interest or aspect of life. One our readership may
wish to take note of is the 2014 talk by Edward Snowden (given remotely) about
how we take back the internet. Currently, you can view TED content without
registering or signing in, but the option to register or sign in is available.

Free Photo Editing Software

E.V.E.R.Y.O.N.E., it seems, has the ability to shoot LOTS of high quality photos
these days, thanks to the widespread proliferation of mobile devices with high
resolution digital cameras in them. And, people are shooting LOTS of high quality
digital photos. There’s going to come a day (if it hasn’t already) that you will want
to tweak or edit one of those digital photos. When you do, you will need some
software to make that possible.

Fortunately, as users of FOSS software, we already have one of the absolute
BEST graphics and photo editing software packages on the planet: GIMP. Many
of the PCLinuxOS new installations already come with GIMP preinstalled. If it’s

not on yours, you can easily install it from Synaptic. GIMP is celebrating its 25th
birthday, too!

GIMP rivals the commercial graphics/photo editing software in both quality and
ability. In some cases, you might have to change your methods a bit (compared
to the commercial software), but the ability is definitely there. If you don’t believe
me, go look at one of the GIMP forums (there are several … a quick internet
search will point you in the right direction). There are some real masterpieces
being produced with GIMP, and many are shared on those forums. Like with just
about everything and anything else, there will be a learning curve.

From the GIMP website:

“GIMP is a cross-platform image editor available for GNU/Linux, OS X, Windows and
more operating systems. It is free software, you can change its source code and distribute
your changes.

Whether you are a graphic designer, photographer, illustrator, or scientist, GIMP
provides you with sophisticated tools to get your job done. You can further enhance your
productivity with GIMP thanks to many customization options and 3rd party plugins.”

Pixlr is another free photo/image editor that gives users easy access to a high
quality editing platform. But what sets Pixlr apart from any other photo/image
editor is that it is a web-based application where you do all of your editing in your
web browser.
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Pixlr actually has two online photo editors. Pixlr X is the “easy to use” photo
editor. They also call it “Playful Pixlr.” Pixlr E is the “Powerful” photo editor for
“Pros.” They also refer to it as “Advanced Pixlr.” In your browser, they look a lot
like GIMP or any other photo editor you’ve likely used. You will find a lot of the
same tools and menus, including filters to apply to your images.

Besides the two online editors, there is a third editor that is dedicated to the
removal of backgrounds from images. It is called Pixlr BG. When you upload your
image, AI (artificial intelligence) attempts to automagically remove the
background of your image. This takes only a few seconds. In my case, with the
“portrait” of my son’s favorite chicken (Optimus), it was close but not exactly what
I wanted (it removed too much of Optimus from the right side of the image for
what I wanted). So, I hit the “Reset” button and removed the background myself,

using the magic wand tool for the larger areas, and then a brush for the finer
detail work of removing the background up close nearest Optimus.

The image in the previous column shows the unaltered, original image on the left,
and the image on the right is after removing the background. To be honest, it’s
the easiest time I’ve ever had removing a background from a photo. The entire
process took me around five minutes, although I probably could have spent a
little more time doing the “touchup” work with the brush. Still, the results were
impressive, easy to achieve, and good enough for my intended purpose.

Being web-based, Pixlr is available to all users, regardless of what platform they
are using. There is a special mobile version of Pixlr available for use on mobile
platforms. Just download the Pixlr Mobile app from either the Google Play Store,
or from the iOS App Store to your mobile device.

All of these features are available in the free version, but keep in mind that the
free version is supported by advertising. Pixlr also offers a “premium” package,
which is ad free and has some additional benefits for just under $60 (U.S.) per
year (or $7.99 per month, if you choose to pay monthly). For the really creative
person, there is a “Creative Pack” level that provides access to even more
features. It costs $29.99 monthly, or about $180 for an annual subscription. For
comparison purposes, Adobe Photoshop has gone to a cloud-based
subscription/support system, which costs around $10 per month, or $120 per
year for the 20 GiB basic plan. So the Pixlr “premium” package comes in at about
half the cost of the Adobe Creative Cloud plan.

Free Music

If music is more your “thing,”
you’re in luck. Although I’m sure
you can find music to stream or
download from many, many
sources, we’ll stick with the
“standard” fare here. All of the
sites listed below require
registration and logging in
before listening to your favorite

music or programming. None of them, as far as I can tell, allow downloading of
music or programming.

Spotify is one of the premiere music streaming sites. There is a free version of it,
which is supported by advertising. The free version will allow you to add artists,
albums, and individual tracks to your library. Spotify Premium allows users to
stream music free of ads, but will set you back $10 per month, and other plans go
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up from there. For that subscription, premium users also get to download music
and are awarded unlimited “skips.”

Pandora is another popular music streaming site that is advertiser supported.
There are a few different paid plans, starting at $4.99 per month for Pandora
Plus, followed by Pandora Premium for $9.99 per month. There are also family,
student and military plans available. The paid plans provide unlimited “skips,” ad-
free personalized radio stations, and access to your favorite podcasts.

Last.fm seems to have lost some of its luster from 10 to 12 years ago, when it
seemed to be all the rage. However, it is still around. You can listen to your
favorite artists or music genres in the free version. Pay attention to your
preferences. You have to choose whether to play your music via a Spotify
Premium account, or via YouTube. Initially, nothing would play for me on Last.fm
until I changed from the default Spotify Premium setting to YouTube. There is a
paid version, called Last.FM Pro, which provides ad-free listening. It will cost you
$30 for an annual subscription, or $36 a year ($3.00 per month) if you go with a
monthly subscription.

If listening to radio stations from all around the world is more your thing, or if
you’re living in a place far from your homeland (and would like a taste of your
homeland to remedy your homesickness), Shoutcast has you covered. They
literally have radio stations from all around the world available for streaming.
Over 87,000 radio stations stream over Shoutcast. The streaming was free and
easy, but with a caveat. I was unable to consistently playback the streams in
Firefox or Chrome. To circumvent that issue, from the left side of the station
listing is a play button. Right next to the play button is a download link. Click on
the download link, and select the “Any player” option to download a M3U playlist.
Then, tell your browser to open the M3U playlist in VLC. It worked perfectly, every
single time. Shoutcast is the only exception in this list in that it doesn’t require you
to log in to listen to a stream.

You can also be your own DJ or program director. On Shoutcast, you can start
your own radio station. The prices range from free (Shoutcast Freemium) to
Shoutcast Premium to Shoutcast for Business. The first two require you to self-
host your radio stations, while the latter is hosted on Shoutcast servers.

Another good, free radio streaming site is IHeartRadio. Currently, only the
countries of the United States and Mexico are showing up as options for me.
Select the area that has the radio station(s) you want to hear, and then select
your favorite station (provided that your favorite station simulcasts on
IHeartRadio).

Finally, don’t forget to check out the webpage for your favorite radio station. Most
radio stations (at least in the U.S.) have a link on their webpage to allow you to

“listen live” to the current over-the-air broadcast. This will enable you to stream
your favorite radio station in an open tab in your browser. The simplicity in this is
that you won’t have to worry about where to find your favorite radio station’s
internet stream. It’s right there on their website.

Extra Savings

My apologies to my non-U.S.
based readers, but this section
is mostly for our U.S. based
readers. Please, check in your
locale to see if anything like the
following is available. It can
save you some serious money.

While these are not free, they
can save you a serious amount
of money. And, of course, the
more money you can save on
miscellaneous purchases, the
more money you have for the
“essentials” or even extra “non-
essential” expenditures. Plus,

who wants to pay full price for something when you don’t have to? Everyone
LOVES a bargain.

RetailMeNot is a site that seeks out deals from retailers all across the country,
and then lists them on their website. Plus, if there’s a special promotional code to
get the discount, it collects those, as well. So, before you go to purchase
something that isn’t on sale and that doesn’t have an obvious promotional
discount code, it could be beneficial to check out RetailMeNot before you make
or complete your purchase. Major U.S. retailers like Bed, Bath & Beyond, Target,
Walmart, Lowes, and Old Navy are represented. You will also find discounts on
restaurants like Red Lobster, Papa John’s, Pizza Hut, Outback SteakHouse,
Olive Garden, Panera Bread and many others. There are also discounts on hotel
and motel accommodations, as well as auto parts and service, electronics, baby
stuff, beauty supplies, pet food and supplies, entertainment, travel, toys, photos,
and lots more.

Groupon is another site where users can get significant discounts on a wide
multitude of products and services. Just supply your location information and you
will find discounts all around the location you’ve specified. Included are discounts
at restaurants, massage therapy services, car repair/service, hotels/motel
accommodations, entertainment, sporting events, and many, many more.
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GoodRx is a site that finds the least expensive price for prescription drugs. It’s no
secret that prescription drugs in the U.S. are outrageously priced (especially
compared to the rest of the planet), so every and any savings is welcomed relief.
Until you look for yourself, it’s hard to understand just how widely the prices vary
for prescription drugs in the U.S. For many Americans, prescription drugs are a
significant monthly expense, and GoodRx can help save up to 80 percent on the
price of those prescription drugs. Typically, users look up their prescription and
print out the coupon for the pharmacy they are going to use. However, users
don’t have to actually print out the coupon. If users have the mobile app, they can
just pull the coupon up on their mobile device and show it to the pharmacist
behind the counter, so the pharmacist can enter the proper codes into their
system to apply the coupon. In many cases, the GoodRx coupon prices are
cheaper than the prices in some health insurance plans (provided they even
cover prescription drugs, at all), so it is worth the while to check before filling a
prescription.

Finally, if you are a MLU (Mature Linux User), be aware of discounts for seniors.
Each company seems to define it a little differently as to who qualifies for a
“senior discount,” but it certainly doesn’t hurt to seek out the information. Some
businesses consider anyone over 55 a senior, while others embrace the “senior”
benefits at 60, 62 or 65 years of age. Of course, you can join the AARP
(American Association of Retired Persons) at the age of 50. That alone will net
you many discounts, and the AARP serves as an excellent clearinghouse of
information on senior discounts.

Summary

I’ve covered a LOT of freebies and major discounts here in this article. I have no
doubts that you will likely find others out there in the wilderness called the
internet. But, these that I’ve listed here should give you plenty of free and low-
cost options to chew on for quite a long time.

If you happen to find other freebies and/or significant savings, please share them
with the rest of us. Ideally, you can post them in the PCLinuxOS forum. Or, if you
want, send them to me. I will collect them, and if I get enough of them, I’ll write up
a followup article sometime in the future.

Now… go get busy collecting freebies and saving some money!

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!
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INGREDIENTS:

1 1/2 pounds boneless rib eye steak
1/4 cup reduced sodium soy sauce
2 TBSP brown sugar
3 cloves garlic minced or crushed
1 TBSP fresh ground ginger
2 tbsp sesame oil
1/4 cup apple or pear juice
2-3 green onions - thinly sliced

Or just buy a bottle of premade Bulgogi sauce at
your local Walmart or Trader Joe's store.

Whatever you do DO NOT confuse Bulgogi with
Gaegogi (Dog Meat)

DIRECTIONS:

Wrap steak in plastic wrap, and place in the freezer
for 30 minutes. Unwrap and slice across the grain
into 1/4-inch thick slices. (or have your butcher slice
it for you)

In a medium bowl, combine apple or pear juice, soy
sauce, brown sugar, sesame oil, garlic, and ginger.
In a gallon size Ziploc bag, combine soy sauce

mixture and steak; marinate for at least 2 hours to
overnight, turning the bag occasionally.

Heat 1 tablespoon vegetable oil in a cast iron grill
pan over medium-high heat.* Working in batches,
add steak to the grill pan in a single layer and cook,
flipping once, until charred and cooked through,
about 2-3 minutes per side. Repeat with remaining 1
tablespoon vegetable oil and steak.

Serve immediately, garnished with green onions and
sesame seeds, if desired.

TIPS:

Replace the beef with chicken or pork

Carbs: 15g Calories: 489
Fiber: 2.6g Sodium: 571mg

Connect connections in one
convenient location!

All your
PCLinuxOS

PCLinuxOS Recipe Corner

Korean Style BBQ Beef Bulgogi
Bulgogi (bul-gow-hee)

http://www.pclinuxos.com
http://pclosmag.com/links.html
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by Meemaw

Valentine’s Day is coming up, and sometimes I wish
I could make something completely different for a
card for a loved one. The cards we get at the store
are always beautiful, but sometimes home-made is
the best. I saw this tutorial that looked really fun so I
thought we could try it. This has a sun-ray sort of
background that I wanted to create, so we’ll do that
first.

Open Inkscape, and start by drawing a long triangle.
Duplicate it, flip it, and position the two triangles with
their points touching. Group them together.

To create all of the ones we want to create, we’ll use
Edit > Clone > Create Tiled Clones. With the
Symmetry setting as Simple Translation, use the
settings at right.

This should make a circular pattern like below. I can
see that mine wasn’t lined up perfectly, but we’ll use
it.

Now choose your radial gradient and choose two
shades of your desired color to use in the gradient.
Apply to the sun-ray pattern. Then, draw a rectangle
the same size as your page and add a linear
gradient to it. (My Inkscape was acting a bit funny so
the shades of blue in my radial gradient look alike.)
You should get something like this (next page, top
left):

Lock the layer that all these are on, and create a
new layer for your hearts and flowers. The hearts
and flowers are your design and your decision as to
how many you want to do, but let’s make a main
Valentine’s heart.

Inkscape Tutorial: Valentine's Hearts & Background
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Using your Bezier tool, you can make “half” of a
heart, pulling those nodes (as ms_meme has said)
until you have it the shape you want.

Duplicate it and flip it horizontally, then align the two
halves together using Align and Distribute. With
them both selected, go to Path > Combine and put
them together. You also need to choose the nodes
at each point (there are two in each place where the
halves come together) and click on Join Selected
Nodes. Change the Stroke to your desired color and
use Linear Gradient on the fill.

OK, now duplicate this heart, size it down a bit,
change the color a bit and stack them.

My heart above has a bit darker reds and pinks on
the bottom than on the top. The border of the bottom
heart is dark red, 4 px, and the border on the top
heart is grey, 2 px. You may do it differently.

From this heart, you can duplicate, recolor, and add
flowers, shadows or whatever. The original tutorial
that I read had a couple of flourishes that could be
added for decoration as well. Here is one of the
flourishes.

Inkscape Tutorial: Valentine's Hearts & Background

https://www.madera.k12.ca.us/cms/lib/CA01001210/Centricity/Domain/2631/Inkscape_20-ValentineDayHearts.pdf
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I duplicated the heart several times, filled them with
different colored gradients and positioned them in
my drawing. Using one of the hearts, I went back to
Create Tiled Clones, set the rows and columns to 1
and 6 (for the sun-ray it was 1 and 12), and set the
rotation to 60 rather than 15. This makes a cute
flower!

I can add something to the center to make it more
colorful.

I imported that flourish, and with it selected, I did
Path > Trace Bitmap. That will make a tracing of
the flourish without the white background (which
would be hard to insert into this project!) Choosing
the trace, I duplicated it a couple of times, changed it
to while, and inserted it into the project in different
spots. When I had everything arranged as I desired,
I added a Valentine’s wish at the bottom.

I’ll remind you that when you export this, be sure to
export the PAGE. If you export the drawing, and you
have any extras at the side that you didn’t use, they
will be included in your export. That’s also how you
get the sun-ray object squared off even with the
page edge. I also put a 1 px border around it, but
that is your choice.

We used Create Tiled Clones, Gradients, and
Duplicate an awful lot, and even did a Trace Bitmap.
I’m sure your creation will be awesome! Have fun!

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Inkscape Tutorial: Valentine's Hearts & Background

http://www.pclinuxos.com
http://www.fsf.org
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by Paul Arnote (parnote)

Commander Montgomery Scott Beamed Up To
The ISS… Sorta

Nearly everyone who has seen Star Trek knows
James Doohan, the Canadian-born actor who
played Commander Montgomery “Scotty” Scott, the
Chief Engineer of the U.S.S. Enterprise. Born in
1920, one of his dying wishes was to have some of
his ashes flown into space. James Doohan died in
2005.

The attempts to get Doohan’s ashes into space were
not necessarily an easy task. In April 2007, ¼ ounce

(7g) of Doohan’s ashes joined 308 others on a
memorial flight into space. The flight was a short four
minute suborbital flight into space, where the ashes
remained onboard, until a planned return by
parachute to Earth. Another attempt was made in
August 2008, aboard Falcon 1, in what was
supposed to be a low earth orbit. However, that
rocket failed two minutes into the mission. Then, in
2008, private astronaut Richard Garriott smuggled
aboard the ISS (International Space Station) on a
laminated card, and it remains hidden under the
floor cladding of the ISS’s Columbia module.

The presence of Doohan’s ashes aboard the ISS
remained secret until December 25, 2020, when The
Times (London) reported the “event,” ending 12
years of secrecy. Previously, only Garriott and
Doohan’s family had any knowledge of his ashes
being aboard the ISS.

In the ensuing 12 years, Doohan’s ashes have
racked up over 1.7 billion miles in space aboard the
ISS, orbiting Earth more than 70,000 times.
However, this is not the end of the story.

In 2012, a small urn containing some of Doohan’s
ashes was flown into space aboard the SpaceX
Falcon 9 rocket, as part of the COTS Demo Flight 2.

In the end, Scotty himself was “beamed up” into
space… the final frontier.

ICYMI: Some “Interesting” Articles TechRepublic
“Passed On” From 2020

I don’t include things like this very often, but I had to
make an exception. We all know how utterly horrible
2020 was. It was easily the absolute worst year in
recent memory. The COVID-19 pandemic, Asian

murder hornets arrive in the U.S., whacked out
politics, the fires in Australia, the fires in the western
U.S., and many other calamities gathered headlines
in a year that most of us would like to forget, and
hope doesn’t get repeated anytime soon.

When I read this list, I laughed out loud. It is a list of
article ideas that were pitched to TechRepublic that
they decided to pass on … as in, not write about. If
they even bring a smile to your face, then great. It
had a similar effect on you, as well. We could all use
a little levity after enduring the onslaught of calamity
after calamity after calamity in 2020.

KFC Bucket PC Chicken Warmer. At first, you
might think that KFC (Kentucky Fried Chicken) has
entered the PC business. But no, they have not. At
least, not directly. Instead, Cooler Master has
created a PC that also keeps your chicken (or other
foods) warm while you game or otherwise use your
PC. It sounds a bit weird to me, seeing how heat

Short Topix: Your Smartwatch
Could Help Detect COVID-19 Earlier

https://en.wikipedia.org/wiki/James_Doohan#Death
https://www.thetimes.co.uk/article/ashes-of-star-treks-scotty-smuggled-on-to-international-space-station-6lpgs05n6
https://www.thetimes.co.uk/article/ashes-of-star-treks-scotty-smuggled-on-to-international-space-station-6lpgs05n6
https://www.techrepublic.com/article/working-from-home-in-the-nude-and-pcs-that-warm-chicken-7-stories-we-didnt-write-in-2020/
https://www.techrepublic.com/
https://landing.coolermaster.com/kfconsole/
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and electronics usually don’t make for a long, stable
marriage.

Maskfone Mask/Wireless Headphone. OK. Give
them props. They were at least thinking about how
to solve a problem with all of the mask wearing the
pandemic has thrust upon us. But there are two
huge problems that crop up. First, the price is a bit
steep at $50 (U.S.) for each one. Second, since we
should be washing out masks daily, it seems a bit of
a hassle to remove all the sensitive and fragile
electronics every day before washing the mask
fabric.

Over 10% of people working from home do so
naked. As in, without clothes on. There’s no
question that the pandemic drastically changed
(probably irreversibly) how we work. A LOT more
people “worked” from home, by telecomputing.
According to a Kaspersky survey, 11% of
respondents admitted that they like working sans
clothing. Another 36% admit to waking up just five
minutes before they have to “be” at work. 23% admit
to binge-watching content on Netflix, and 18% admit
to playing more video games. Let’s just hope that
those 11% who like to work naked have their
webcams covered!

Check out the rest of the list by heading over to
TechRepublic to read “the rest of the story.”

Your Smartwatch Could Help Detect COVID-19
Up To A Week Before You Develop Symptoms

A variety of smartwatches, including those from
Apple, FitBit, Garmin and other manufacturers, could
help detect persons infected with COVID-19 seven
to nine days before they develop symptoms,
according to a pair of studies.

One study from Mount Sinai medical center found
that measuring heart rate variability (HRV) with an
Apple smartwatch, while wearers recorded and
tracked any possible symptoms (fever or chills,

tiredness or weakness, body aches, dry cough,
sneezing, runny nose, diarrhea, sore throat,
headache, shortness of breath, loss of smell or
taste, itchy eyes, or none), found significant changes
in HRV up to seven days before the patient started
showing symptoms. HRV is a metric used to
measure immune system health. HRV values
change as inflammation develops in the body, and
COVID-19 is a disease with high levels of
inflammation. Ironically, researchers also discovered
that seven to 14 days after the diagnosis of COVID-
19, HRV returned to normal and was statistically no
different from those who had not been infected.

A second study out of Stanford University (beware:
lots of mumbo jumbo technobabble) found that 81%
of COVID-19 positive study participants were
informed of an irregularity in their HRV up to nine
days prior to the onset of symptoms using a variety
of smartwatches from multiple sources and special
apps to detect and analyze the detected/measured
HRV.

The two studies have spurred the development of
custom COVID-19 wearables that are 90% effective
in early detection of the virus. The wearable, called
Empatica E4 and utilizing an AI product called
CovidDeep, monitors regular skin, heart rate, and
blood pressure readings to make its mostly accurate
detection.

Earlier detection could help save lives, detecting
COVID-19 infections long before symptoms appear,
and long before viral loads skyrocket. A lower viral
load could mean easier, more effective, earlier
treatment, and thus a lower mortality rate.

Brave First Browser To Support IPFS

The Chromium-based Brave browser may have just
set the browser world on fire with its new support of
IPFS. Interplanetary File System works sort of like
BitTorrent or other peer-to-peer file sharing
sites/programs in that instead of downloading one
file from one server, users use IPFS to download
chunks of a file from multiple nodes on the IPFS
server. This can seriously cut down on the amount of
time it takes to download a file.

An article from Lifehacker explained it like this:

Each computer or mobile device—known as
“nodes”—temporarily stores a piece of a website’s data.
So whenever you access a website via IPFS, you’re
loading the data from other nearby nodes on the network.
Users can also access IPFS content via a “public
gateway,” if they do not wish to act as a local node.

The other advantage that IPFS has is that it
decentralizes the web, making it much more difficult
for censorship to rear its ugly head. With bits of files
downloaded from multiple sources, it makes it
infinitely more difficult to block files with content that
others want to see limited or eliminated.

Some of the other benefits of using Brave is that
they claim to be the fastest web browser around.
This is not only, in part, due to its support of IPFS,

Short Topix: Your Smartwatch Could Help Detect COVID-19 Earlier

https://www.techrepublic.com/article/working-from-home-in-the-nude-and-pcs-that-warm-chicken-7-stories-we-didnt-write-in-2020/
https://health.mountsinai.org/blog/mount-sinai-reseachers-use-apple-watch-to-predict-covid-19/
https://www.nature.com/articles/s41746-020-00363-7
https://lifehacker.com/what-is-ipfs-and-why-does-it-matter-in-braves-web-brows-1846103479


PCLinuxOS Magazine Page 24

but also its superior ad and tracker blocking, along
with its built-in ability to also block location reporting.
Brave claims to be three times faster than Firefox
(the fastest browser of the major browsers) and up
to six times faster than Chrome or Safari.

Being based on Chromium, you can download and
use your favorite Chrome plug-ins and add-ons
freely. The Brave browser is available for installation
from the PCLinuxOS repository.

Don’t get the idea that using IPFS will mask what
you are downloading. Your ISP can still track what
you are downloading, just as they do with the
downloading of files from a single URL. To do that,
you will need end-to-end encryption, as is often
offered with the use of a VPN. But, because of the
multi-nodal nature of IPFS, it becomes a lot more
difficult to block access to the content you wish to
obtain. The aforementioned Lifehacker article does
an excellent job explaining IPFS.

How Do Animals See The World?

The HomeAdvisor website ran a very interesting
article recently, called “How Pets See Your Home.” It
compared what a human sees to how your pet (or
other animal) sees the world. They were able to
figure out how each animal sees, by comparing eye
structure, the number of rods and cones, eye
placement, and a few other variables.

Dogs live in a pastel world of shades of blue and
yellow (and combinations of them). They possess
only 20% to 40% of their human counterpart’s visual
acuity, but compensate with a 240 degree field of
view.

Cats color perception is somewhere between that of
a dog’s on the low end, and humans on the upper
end of the scale. Their field of vision is
approximately 200 degrees. But where cats really
excel is in their low light vision.

Parrots, like most birds, have a highly developed
sense of vision. They can see UV (humans can’t),
blue, green and yellow. They can also see
approximately 300 degrees, have monocular vision
(one eye can view something, while the other
wanders around), can adjust their focus very quickly,
and have voluntary control of their pupils.

Spiders have rather weak eyesight, despite having
around eight eyes. Their eyes don’t contain cones
(the color sensing part of the eye), instead relying on
proteins called ospins, which might be sensitive to
certain colors, which may help them with mating.

Spiders rely more on the little hairs all over their legs
to feel their way around, more so than vision.

Goldfish can see more colors than humans, with
their eyesight extending into the UV range. This
should help the goldfish see with more clarity
underwater, as well as help the goldfish see where
Fido has marked your sofa as part of his territory.
Their eyes can see almost 360 degrees (ever
wonder where we get the term fisheye lens?), and
their eye density is nearly the same as water, which
may help compensate for the bending of light in
water.

Short Topix: Your Smartwatch Could Help Detect COVID-19 Earlier

https://www.homeadvisor.com/r/how-pets-see/
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It’s a fascinating world, made even more fascinating
by discovering how different animals see the world.

New Course From The Linux Foundation

The Linux Foundation has created a new course,
aimed at beginners. It is called “Open Source
Management & Strategy.” It has seven modules,
each with four to five lessons per module.

This seven-module course series builds on the
accumulated wisdom of many previous training
modules on open source best practices, while
adding fresh and updated content to explain all of
the critical elements of working effectively with open
source in your enterprise. The courses are designed
to be self-paced, and reasonably high-level, but with
enough detail to get new open source practitioners
up and running quickly.

Here are the seven lesson modules:

* Open Source Introduction (LFC202): Course
Outline

* Open Source Business Strategy (LFC203): Course
Outline

* Effective Open Source Program Management
(LFC204): Course Outline

* Open Source Development Practices (LFC205):
Course Outline

* Open Source Compliance Programs (LFC206):
Course Outline

* Collaborating Effectively with Open Source
Projects (LFC207): Course Outline

* Creating Open Source Projects (LFC208): Course
Outline

Who It’s For. This course series is designed to help
executives, managers, and software developers
understand and articulate the basic concepts for
building effective open source practices within their
organization. It is also helpful for a leadership
audience responsible for setting up effective
program management of open source in their
organization. Before enrolling, students should have
a basic understanding of software development and
business concepts.

What You’ll Learn. In the first module (LFC202),
you will learn the basic components of open source
and open standards. You will also learn about the
differences between open source and closed source
software, the reasons for the use of each, and how
the combination of standards and open source
provides increased value to an organization. The
second module (LFC203) discusses the various
open source business models and how to develop
practical strategies and policies for your
organization’s chosen model. It also explains the
value and importance of an Open Source Program
Office (OSPO) as well as how the OSPO helps

provide assistance in defining ROI and other open
source metrics. In the third module (LFC204), you
will learn how to build an effective OSPO and
articulate the different types of roles and
responsibilities needed to run it successfully. Module
4 (LFC205) talks about the role of continuous
integration and testing in a healthy open source
project, and how you can apply open source
development principles to internal projects within
your organization to take best advantage of the
value these principles bring. In the fifth module
(LFC206) you will learn about the importance of
effective open source license compliance and how to
build programs and processes to ensure safe and
effective consumption of open source in the
enterprise. You will also get familiar with the most
common open source license types, and their major
characteristics, as well as how to choose the most
appropriate license for a given situation. Module 6
(LFC207) discusses how to work most effectively
with upstream open source projects and how to build
sound contribution strategies in organizations to get
the maximum benefit from working with project
communities. It also describes multiple common
upstream project governance models, and explains
how these governance practices affect an
organization’s ability to make effective contributions.
Finally, the last module (LFC208) discusses the
rationale and value for creating new open source
projects as well as the required legal, business and
development processes needed to launch new
projects.

What It Prepares You For. Upon completion of this
course series, you should be able to build effective
processes and strategies for creating new open
source projects from scratch, or from open sourcing
previously closed source projects within an
organization.

The course will cost you $499 (U.S.). It is an online,
self-paced course, and registrants have unlimited
access to the online course materials for a period of
one year to complete the course.

Short Topix: Your Smartwatch Could Help Detect COVID-19 Earlier
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by CgBoy

FSearch is a very fast standalone file search utility
inspired by the Windows-only Everything search
engine. FSearch indexes file directories and builds a
database, allowing you to get almost instant search
results as you type. This makes FSearch extremely
fast when compared to many other search tools built
into file managers.

The interface is fairly simple and well designed,
making FSearch quick and easy to use. The search
results will appear as a list below the search bar.
Down at the bottom of the screen are indicators
showing how many files have been found, and how
many files have actually been indexed.

Before you can start searching for files, you have to
add some directories to the database. Go to the
preferences, accessible from the Edit menu, and
head to the Database tab. From here, you can now

add the directories that you want to be able to
search in, such as your home folder. You can also
choose folders that you want to be excluded from
the search database, and you can even exclude
certain file formats. FSearch can be set to
automatically update the database each time the
program starts, so you can be sure that all recent
files get indexed. To manually update the database,
press Shift-Ctrl-R. Depending on the size of the
folder, however, it may take quite a while for
everything to be indexed.

As soon as you’ve added some folders to the search
database, FSearch will be ready for use. Once you
start searching for something, the results will appear
almost instantaneously. You can set it to search for
files only, or folders only, or both. The search results
can be sorted by name, file path, type, size, and
date modified. You can also open or delete any file
listed in the search results, or open the folder that
the file is located in. FSearch also has RegEx
support, for more precise file searching.

Summary

All in all, I found FSearch to work very well in my
testing, although one of it’s biggest drawbacks is that
it can take quite some time to update the file
database. After that though, it’s very fast when you
actually need to find something. If you’re looking for
an easy to use, PCLinuxOS alternative to the
Everything search tool, I believe FSearch is a good
choice.

Repo Review: FSearch

https://www.edx.org/course/introduction-linux-linuxfoundationx-lfs101x-0#!
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As told to Mr Cranky Pants-YouCanToo

What is your name/username?

cdbc

How old are you?

50

Are you married, single?

In a relationship with Sabine. She used to live in
Hamburg, but moved here with me in Denmark.

How about Kids, Grandkids (names and ages)?

No & no

Do you have pets, what is your favorite?

No

Are you retired, still working and if working, what
do you do?

I'm still working the last many years as a carpenter,
building new houses. Before that, I was CTO in the
computer company, which dealt with medical
systems. I built the hardware, installed it, was on the
software team who developed it and finally reverse
engineered our competitors data, when we took over
a client, that was great fun. And in my younger
years, I was a ski-instructor in St. Anton am Arlberg.
Let me just say, that it was a lot of laughs.

Where do you call home? What is it like? IE:
weather, scenery

We live on the east coast of Jutland in Denmark,

eight kilometers (4.9 miles) from the sea. It's
beautiful here, hills, woods, the sea, well it's just
nice, if it wasn’t for the rain. We have good days too,
mainly in May and August.

Where did you go to school and what is your
education level?

I got my master of computer science in Lyngby, at
DTU (Danish Technical University).

What kind of things do you like doing? hobbies,
travel, fishing, camping?

Well, obviously skiing, waterskiing and a little bit of
motocross.

Why and when did you start using Linux?

2005. My first was Fedora. Somewhere I stumbled
upon PCLinuxOS and I've been here ever since. I
got fed up with winblows, as simple as that.

What specific equipment do currently use with
PCLOS?

I've two Lenovo Laptops for business and a shiny
red HP laptop for play. All of them are running
PCLinuxOS, one 32 bit LXDE and the other two 64
bit KDE.

PCLinuxOS Family Member Spotlight: cdbc
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Do you feel that your use of Linux influences the
reactions you receive from your computer peers
or family? If so, how?

Yes, I'm some kind of Linux ambassador here in my
neck of the woods. My spouse got her first five years
ago and she is a happy camper.

What would you like to see happen within
PCLOS that would make it a better place. What
are your feelings?

I'm happy, so keep up the good work everybody. On
my wishlist is only one item: could somebody please
compile the "MuPdf" as a library (*.so), as I can't get
the makesystem to work (I'm not C savvy). I just
need the one *.so file, so it doesn't have to be a
package. There's a guide on their website. Pretty
Please….

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum members. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.
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by David Pardue (kalwisti)

Background

Many modern routers have a built-in USB port which allows you to easily share
an attached drive with all of the computers on your home network – wired or via
Wi-Fi. I attempted to set this up with our Wi-Fi router (a TP-Link AC4000) and an
old Seagate Barracuda HD (80 GB) that was already in a 3.5” external drive
enclosure. You may use any type of drive with a USB connection – external HDD
or SSD, portable HD or even a high-capacity flash drive.

Caveat: Although my experiment succeeded, I am not a network guru by any
stretch of the imagination, so the procedure outlined here might not be the most
efficient or technically correct. However, you might find this write-up helpful if you
are trying to accomplish this for the first time. I hope it will save you some time
and effort.

You should have realistic expectations about the performance of this “home
cloud.” A router’s primary function is to host your network, so it will not be as

capable as a dedicated NAS (Network-Attached Storage) server – such as those
made by Synology, QNAP, or Western Digital – costing hundreds of dollars.
Nevertheless, if you only want some casual network storage larger than the limits
imposed by free services such as Dropbox, Box, Google Drive or even PCLOS-
Cloud1, the approach outlined here is an inexpensive way to get more use out of
your Wi-Fi router. Another advantage of this approach is that data transmission
occurs only within your local network; no traffic is sent out to the internet unless
you tell it to do so.

Preparing the Hard Drive

The TP-Link AC4000 has a USB port which can share resources on a USB
device via FTP and Samba. It supports the NTFS, FAT32, exFat and HFS+ file
systems; no native Linux file systems are supported, unfortunately.

I opted to use NTFS, so my first step was to format the Seagate HD using
GParted. I created a single large partition for data storage with ntfs as its file
system.

Next, plug your drive into the router’s USB port and power it up.

Enable USB Drive Sharing

You will need administrative access to your router in order to activate USB drive
sharing; this feature might also be referred to as Drive storage, File sharing or
something similar. From any computer on your network, open a browser and
navigate to your router’s IP address. You can often find this information on the
back of the router, printed on a reference card that came packed in the original
box, in the device’s manual, or online (the manufacturer’s website). In most
cases, the IP address will look like 192.168.X.X.

This particular TP-Link Wi-Fi router is managed/accessed from the address
http://tplinkwifi.net. (The address http://192.168.0.1 also works). When the page
loads, you must log in with your username and password. If you have never
changed your router’s default credentials, there is a good chance that the
username is admin, and the password is admin – as this convention is used by
several manufacturers (TP-Link, Netgear, Linksys, etc.).

Sharing A USB Drive From Your Wi-Fi Router

http://tplinkwifi.net
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The web-based management page of my AC4000 looks like this:

After logging in, the configuration section for USB sharing is shown below. The
router’s management software auto-assigned the name volume1 (G:) to the
Seagate Barracuda HD:

The software assigns the default name TP-Share to the external HD (although
you may change its name if desired). You can also see the server’s SMB and
FTP addresses.

Although sharing the drive can be customized – by specifying that only certain
folders on the HD may be shared – I chose to allow sharing the entire disk’s
content.

The router allows you to set up authentication for your USB device, so that
network clients will be required to enter a username and password when
accessing the USB disk. However, after some discussion, we decided to turn off
authentication and allow anonymous connections. Only three of us will be using
this network storage, and we are all suffering from password fatigue.

Sharing A USB Drive From Your Wi-Fi Router
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Access Drive/Create a Network Share (in Windows)

If you have a Windows PC in your network, you probably want to make the USB
disk accessible to Windows and map it as a Network Drive (if you plan on leaving
it attached). We configured this from my son’s desktop machine, since he uses
Windows 10 for all his college coursework.

I will not cover this process in detail because you can consult this clear tutorial:

https://www.groovypost.com/howto/share-usb-drive-wi-fi-router/

Burgess, Brian. “How to Share a USB Drive from Your Wi-Fi Router.” groovyPost
26 July 2019.

Package Check

To make sure that everything works correctly, check whether the packages below
are installed on your system. (In my case, they were already present).

• ntfs-3g
• ntfs-config
• samba-common
• cifs-utils

Although Samba is more feature-rich, in this article I will focus on FTP because it
is more straightforward to set up. FTP is OS-agnostic; it works regardless of

which OS you prefer. The protocol was developed in the 1970s by Abhay
Bhushan while he was a graduate student at M.I.T. (Mr. Bhushan is also credited
with authoring early versions of e-mail protocols).

I will discuss four PCLinuxOS DE’s in order of my familiarity with them. I have
primarily been using the MATE desktop since around 2016; prior to that, I ran
Xfce for several years. My first contact with Linux involved KDE 3.5, so exploring
Trinity is a fun blast from the past. Although I used KDE 4, I have been away from
KDE long enough that Plasma 5 makes me feel somewhat lost at sea.

MATE DE

FTP With FileZilla

FileZilla is the most well-known and popular FTP client today. It supports all the
major operating systems – Linux, Windows, macOS – and has built-in security
features. The program’s interface is fairly intuitive; however, I included a few tips
below in case it has been a while since you have used FileZilla.

FileZilla’s default protocol is FTP, so you do not need to type “ftp:// “ prior to the
server’s IP address (Host). The default port for FTP is 21, so you may omit it, if
you wish. In the screenshot below, I included them out of habit.

Sharing A USB Drive From Your Wi-Fi Router
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Since I disabled access authentication for the USB disk, FileZilla gives an
“Insecure FTP connection” warning message when I try to connect to the server.

To dismiss the notification dialog, you can select “Always allow insecure plain
FTP for this server.”

Once FileZilla connects, you will see the USB disk’s contents displayed in the
Remote site panel.

To upload a file (or folder) from your computer to the remote USB drive, right-click

on the source file and choose Upload from the menu. FileZilla will notify you
when it has been successfully transferred.

To download a file (or folder) from the FTP server to your computer, right-click on
the source file and select Download from the menu.

Sharing A USB Drive From Your Wi-Fi Router
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To finish your session and disconnect from the FTP server, click on the ‘offline
computer’ icon in the toolbar.

FileZilla has a neat tool called Site Manager (under the File menu > Site
Manager) that allows you to store information about your previous connections.
You can use it to directly connect to your FTP server, without having to retype the
login details.

Additional information on Site Manager is available from FileZilla’s Wiki:
https://wiki.filezilla-project.org/Site_Manager

Via FTP (using Caja 1.24.0)

From the Go menu > select Location.

In the Location bar, press the eraser icon to delete your current path. Or, you can
manually backspace to delete the path.

Type: ftp://192.168.0.1/G.

Press Enter (or click on the blue
“Go to” arrow).

The “Enter password” dialog
window appears.

Click the Connect button. It
connects to the FTP server (next
page, top left).

To add a bookmark, while Caja
is open, choose “Add
Bookmark” from the

Sharing A USB Drive From Your Wi-Fi Router
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“Bookmarks” menu. Then, right-click on G under Bookmarks, and select Rename.

Type in the new name: TP-Share. When you open Caja next time, the bookmark
is persistent.

Caja has a split window option, which makes it easy to transfer files between
locations. Caja developers call this feature an “Extra Pane.” Activate this from the
View menu > Extra Pane, or press the F3 function key.

Below is a screenshot of Caja with its Extra Pane activated.

Based on my testing, I found Caja’s behavior with FTP a bit flaky – with
unpredictable crashes. This surprised me, because it is typically a rock-solid file
manager. I would recommend FileZilla for dependable FTP use within MATE.

Sharing A USB Drive From Your Wi-Fi Router
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Xfce DE

The FileZilla method works identically to what is described in the MATE section
above.

Via FTP (using Gigolo, with help from Thunar [1.8.15])

Gigolo is a frontend tool to easily manage connections to local and remote
filesystems. The application’s developer, Enrico Tröger2, playfully named it Gigolo
because … (a drumroll, please) … “It mounts what it is told to.” Based on my
experience, Gigolo works well.

Open Gigolo:

From the Actions menu > choose Connect. A “Connect to Server” dialog window
opens. Fill in the information as indicated below:

FTP
Server: 192.168.0.1/G
Port: 21

Then, press the Connect button (next column, top left).

An “Enter password…” dialog window opens. Enter your username and password
(if applicable). Click on the Connect button (next column, top right).

An icon for the remote system should appear.

Open it. N.B.: By default, it will open in Firefox (next page, top left).

Although Firefox can browse/open FTP shares, it is not a “proper” FTP client
because it does not allow you to upload files. Previously, uploading was possible
using the FireFTP add-on; however, that was discontinued in 2017 as a “legacy
extension.”

Sharing A USB Drive From Your Wi-Fi Router
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To change this behavior, select “Preferences” from the Edit menu.

Change “gio open” to “ thunar ” (with a lower-case ‘ t ‘). Close Gigolo. Restart the
application. The next time you connect to your FTP server, Gigolo will open it with
the Thunar file manager.

Creating a shortcut in Thunar is easy. In the left pane of the file manager, under
“Network”, right-click on the FTP share. Choose Create Shortcut.

Sharing A USB Drive From Your Wi-Fi Router
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A new shortcut will appear under “Places” ( / on 192.168…).

To add a bookmark in Gigolo, right-click on the Network share’s icon (from within
Gigolo’s main window). Choose Create Bookmark.

Afterwards, I renamed the bookmark “TP-Share” from within Gigolo’s main
window (not from within Thunar). The default “Name” is 192.168.0.1. I changed it
to “TP-Share.”

Click the OK button.

The folder’s name should be changed to TP-Share.

Click on the icon and the FTP share will open in Thunar.

Unlike the other file managers discussed here, Thunar does not have a split-
screen view. My understanding is that Thunar’s developers intend for it to be a

Sharing A USB Drive From Your Wi-Fi Router
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streamlined system, so that option is omitted. Nevertheless, it is possible to have
two tabs open simultaneously in Thunar (by typing Ctrl+T, or activating it under
the File menu > New Tab).

With two tabs side by side, it is not too burdensome to copy files between the
chosen locations.

Trinity DE

The FileZilla method works identically to what is described in the MATE section
above.

Via FTP (using Konqueror [R.14.0.9])

The venerable Konqueror – Web browser and Swiss Army knife for any kind of
file previewing – is also a decent FTP client. Here are instructions for configuring
it.

On your desktop,
you will see a My
Network Places
icon.

Open it. Next,
open Add a
Network Folder
(next column, top).

The Network Folder Wizard starts. At this screen, choose FTP, and then click on
the Next button.

A Network Folder Information dialog window appears. By default, it is mostly
blank.

I filled in the information as follows:

Name: TP-Share
Server: 192.168.0.1
Port: 21
Folder: (change “ / ” to) G (see next page, top left)

Sharing A USB Drive From Your Wi-Fi Router
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Check/select Create an icon for this remote folder.

Press the Save & Connect button. An icon was added for: TP-Share (in My
Network Places folder). (next column, top)

The link is persistent, so double-clicking on it will open TP-Share.

Thanks to Konqueror’s “Split View” feature, it is simple to transfer files between
your computer and the FTP server.

Under the Window menu, choose either Split View Left/Right, or Split View
Top/Bottom (next page, top left).

Sharing A USB Drive From Your Wi-Fi Router
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Below is a screenshot of the Split View Left/Right.

KDE Plasma 5 DE

The FileZilla method works identically to what is described in the MATE section
above.

Via FTP (using Dolphin file manager [20.08.2])

Dolphin can handily transfer files from a remote location via FTP, Samba or NFS
to your local PC.

In the Location bar/box, click to edit the current location. (It will probably be /
home / yourusername). Erase the text in the box, by pressing the backspace (aka
‘clear’ or ‘delete’) icon.

Then, type in the FTP address. Press Enter. It will connect to your FTP server.

Sharing A USB Drive From Your Wi-Fi Router
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Thanks to Dolphin’s “Places” feature, you can save remote connections for later,
thus avoiding the need to retype the IP address during your next work session.

Click on the “Add Network Folder” wizard.

The wizard will start. In this window, select FTP, and click the Next button:

A Network Folder Information dialog window appears. By default, it is mostly
blank.

Enter the required information (as shown below). Click the “Save & Connect”
button.

The wizard created an icon named “TP-Share” which will successfully connect to
the FTP server (next page, top left).

Sharing A USB Drive From Your Wi-Fi Router
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Once the TP-Share folder appears under the “Network” places, right-click it and
select Add to Places.

The TP-Share folder now appears under Places > Remote > Network (top right).

Dolphin’s “Split view” option (found in the menu on the toolbar) makes it very
convenient to transfer files between your computer and the FTP server.

Sharing A USB Drive From Your Wi-Fi Router
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Conclusion

I hope that you can now enjoy sharing documents, photos, music and/or videos
on your home network, whether you decide to use FileZilla or your favorite
desktop environment’s file manager. Bear in mind that this drive will be
accessible to everyone in your household, so you should avoid storing any
confidential / sensitive files on it.

1 The PCLOS-Cloud service is maintained by our own
TheCrankyZombie (David Moore). For more information on how to
set it up, see his article in the April 2020 issue of The PCLinuxOS
Magazine: https://pclosmag.com/html/Issues/202004/page04.html.

If you are interested in evaluating cloud storage options, check out
the magazine’s series of “Alternatives to Dropbox” articles, written by
Agent Smith (Alessandro Ebersol): Part 1 (Dec. 2018); Part 2 (Jan.
2019); Part 3 (Feb. 2019); Conclusion (Mar. 2019).

2 He is also developer of the cross-platform Geany editor.

Screenshot ShowcaseScreenshot Showcase
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Couple Adopts Six Siblings!

In Texas, Jamie Hejduk and his wife, Heather, began
fostering twin boys who were just two months old.
After starting to foster the two boys, they found out
the boys had four other siblings.

During a virtual court ceremony on November 19,
2020, they officially adopted all six children. This
doubles the family, as they already had four
biological children.

Stolen Puppy Reunited With Its Owner

A little puppy stolen Tuesday night in Pittsburgh has
been reunited with its owner, police said. The four-
month-old mixed breed puppy, named Daphne, was
stolen Tuesday, January 5th.

Debbie Gespass, Daphne’s owner, was taking her
for a walk in the park when an unidentified man
stopped to pet the animal. Police say he then
unhooked Daphne’s leash, picked her up, and ran
off with the dog.

“I was screaming. I was in the street yelling, ‘Help
somebody stole my dog,'” she said. The Gespass
family said neighbors called the police, some
witnesses chased the man, while others gave the
police a description of the man. Sixteen hours later,
Daphne was found alone in another park, and a
police escort accompanied her home.

12 year-old Raises $42000 For Homeless Man
Who Returned Grandma's Wallet

Sean Currey was scrounging for food through a
dumpster behind a California coffee shop in

December when he saw a wallet. He found that it
belonged to 80-year-old Evelyn Topper, of Mill
Valley, as reported by the Washington Post.

Currey, who had been homeless on and off over the
years, admitted that he thought about using the
cards at first, but he ultimately decided to call Topper
and give back her wallet. “Anybody in the position of
being homeless and cold and tired and hungry, if
they found a credit card, they’re going to think about
it,” Currey, 57, told the Post. “But whether you’re
going to act on it is two different things. I would
rather be cold and hungry and know that I did the
right thing,” he added.

Mrs. Topper had lost her wallet the day before, and
did not realize her wallet was missing until she got
home. When it was returned to her, her 12 year-old
granddaughter, Mikayla Gounard, wanted to find a
way to give back. Her mother started a GoFundMe
page on her behalf to raise money for Currey and
others in his situation. As of the original article’s
writing, the page had raised more than $42,000. As
of this writing, it has raised over $54,000.

Their goal was to raise enough money to get Currey
off the streets and into temporary housing so he
could stay “safe and warm.”

Man Restores Cars For Neighbors

A man in North Carolina is busy refurbishing old cars
for neighbors who have no mode of transportation.
Once it is ready to hit the road, a car will go to the
Sharing House Wheels to Work program, whose
mission is to empower individuals by giving them
reliable transportation.

“The last thing you want is a single mom stranded

Good Words, Good Deeds, Good News
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somewhere,” said Chris Lewis, who restores the
vehicles inside his own garage. Lewis said his faith
is the reason behind the work he does for others. He
has restored 80 vehicles in the last 9 years,
including 14 just last year.

“Well, I’m kind of a Matthew 25 guy. So you know, I
think we’re supposed to help people,” he
commented, adding, “It’s just something I know I
need to do.”

Neighbor Sidney Lowe received a 1994 Mercury
Villager through Wheels to Work, stating, “It’s been a
godsend, it’s really helped me out. Otherwise I
would’ve been on foot.”

Teacher Saves Custodian's Life

Custodian Pat Mertens’s daughter put out a
message on Facebook pleading for someone to
donate a kidney to her father.

Erin Durga, a third-grade teacher at Kimball
Elementary School, knew Mertens because he was
the janitor at her school. They had talked many
times while he cleaned her room after school.

When Durga learned that Mertens needed a kidney

transplant, she immediately told her husband she
planned to donate. “About 30 seconds into reading
this, I turned to my husband, and said, ‘Pat needs a
kidney, it needs to be O-type blood, and I think it’s
going to be me,’ she said.”

They turned out to be a match, and in July, they
underwent surgery, and her kidney was given to him.
They both did so well that they were able to return to
work in August.

Screenshot ShowcaseScreenshot Showcase
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by Paul Arnote (parnote)

It might not be the most popular web browser out there. Its popularity peaked in
2009 with a little over 32 percent of the browser “market.” Today, depending on
who is reporting the data, Firefox enjoys between three and nine percent of the
browser market share. But, it has persevered and it is responsible for helping to
shape many of the web standards we enjoy today. Plus, it certainly pre-dates
most of its competition.

Having started “life” as Netscape’s open source browser, born out of Netscape’s
Mozilla community after AOL (remember them?) bought Netscape, Firefox has
been with us for quite a long time. In fact, it has been around since 2002. In full
disclosure, I have been a Firefox user since its inception. For me, Firefox is THE
standard to which I hold all other web browsers.

Why do I like it so much? There are several reasons, with transparency being at
or near the top of the list. The rest of that list (in no particular order) includes
security, extensibility with add-ons, speed, ease of use, embracing of actual
standards, privacy protection, and the list goes on. Plus, when you’ve used
something THAT LONG, you get used to how things are done. It feels
comfortable and right.

It would be virtually impossible to list every single tip or trick with Firefox. There
are probably as many tips and tricks as there are users, thanks to its ability to be
customized for each individual user. But, let’s cover a few tips and tricks that
might be helpful or useful to the average user.

Firefox Task Manager

Have you ever been cruising along and all of a sudden, things slow to a crawl.
While you might be tempted to close Firefox and start afresh, there might be
another way. Sometimes, the result of a slowdown might not be caused by what
you think it is. Fortunately, Firefox has a built-in Task Manager to help you figure
out what (or who) is causing the slowdown.

First, click on the three-line “hamburger
menu” in Firefox, located in the upper
right corner of the Firefox window.

Scroll down to the “More” entry, select it,
and you should see additional menu
entries, as shown above. Select “Task
Manager” from the “More” menu.

Then, you should see a screen that
resembles the image at the top left of the
next page. Listed is every open tab you
have open in Firefox and every
extension and add-on you have installed
in Firefox. The Task Manager will also
display a column listing what each entry
is (Tab or Add-on), it’s “Energy Impact”

Firefox Tips, Tricks & Easter Eggs
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(which is important if you are running Firefox on a device powered by batteries),
and how much memory each item is using.

As you mouse over each item in the list, you should see each line highlighted. If
you find an item that’s consuming more energy or memory than it should, you can
eliminate/stop that (those) item(s) by clicking the “X” at the far right edge of each
line entry.

Sometimes, add-ons will be updated in the background, but the updated add-on
will malfunction, causing a slowdown. Other times, a runaway script on a page
you’re visiting will cause Firefox to become sluggish. Whatever the case, the
Firefox Task Manager should make it abundantly clear what is making your
browsing session move slower than molasses on a bitter cold January night.

Do You Want To Play A Game?

Hidden deep in the source code for Firefox is a hidden gem. Many people call
these “Easter Eggs,” which are secret little “treats” for users to discover, but only
if they hold their mouth just right, spin around on one foot, and catch a fairy in
their right hand… all at the same time.

To be honest, I’m not sure what the “official” name of this Easter Egg is, but I call
it Unicorn Pong. Here’s how you access it.

Step 1: Go to the Firefox “hamburger” menu (upper right corner) and select
“Customize” from the menu. You should see a screen that resembles the
screenshot above.

Step 2: See all of the “tools” on the left side of the screen in the first image? Click
and drag them … ALL of them … to the “Overflow Menu.” Your Overflow Menu
should look something like the image above. The only tool that cannot be
“moved” to the Overflow Menu is the one marked “Flexible Space.”

Firefox Tips, Tricks & Easter Eggs
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Step 3: You will/should notice a new, discreet little button has been added to the
“Customize” screen. It is a little unicorn with a rainbow horn and tail. I’ve “marked”
it with an arrow in the above image.

Step 4: Click the “Unicorn” button. You should see something like the image
above, but on the left side of your “Customize” screen. Your “paddle” is at the top
of the play area. Move your paddle with either your mouse or the left/right cursor
keys on your keyboard, attempting to intercept the unicorn and send him/her
back down to the paddle at the bottom of the screen. It is, actually, a one-player
version of pong.

The image above shows the entire “Customize” screen in Firefox, after I’ve
moved the tools to the Overflow Menu, and as I’ve started a game of Unicorn
Pong.

To put things “back to normal,” just click the unicorn button again to stop play (or
wait until all of your unicorn lives have been used up), then drag the tools back
over to the tool area from the Overflow Menu. Or, you could just hit the “Restore
Defaults” button at the lower right of the screen, and then the “Done” button.

The hidden little game is a fun distraction to keep in mind when you’re mindlessly
waiting for an appointment, a late colleague, or waiting on someone else to finish
up whatever tasks they have going on.

Hello, Humans! We Visit In Peace!

Type about:robots into Firefox’s address bar and a “Welcome Humans!”
message will show up. The message is from robots who “have shiny metal
posteriors which should not be bitten.” It’s a reference to Futurama’s Bender, the
robot whose trademark catchphrase is “Bite my shiny metal @$$.”

The tab is titled “Gort! Klaatu barada nikto,” in an obvious reference to one of
the most iconic phrases in science fiction, from the 1951 SciFi film “The Day The
Earth Stood Still.” The phrase also found its way into the 2008 remake of the film,
starring Keanu Reeves.

Firefox Tips, Tricks & Easter Eggs
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If you click the “Try Again” button, you will receive a message that says “please
do not press this button again.” If/when you do, the button disappears completely.

The Book of Mozilla

These are fun, even if apocalyptic and cryptic in nature, “verses” from the
mythical Book of Mozilla that is embedded in the Firefox code. The verses have
appeared since 1998, when Netscape first open-sourced its browser code. The
“verse” changes periodically.

The current “verse” (shown above) is the current one that was inserted starting
with the Firefox 80 Nightly builds. You can access them easily enough, simply by
typing “about:mozilla” in the Firefox address bar.

If you want to see all of the Book of Mozilla verses that have appeared since they
began (there have been seven verses released), along with a brief history of
them, I recommend that you check this out. This link also contains verses that
appear in browsers that are derived from Firefox. Or, if you just want to read the
verses (Netscape/Mozilla/Firefox only) without any historical (or other) context,
you can see them all here.

About About

There are a LOT of built-in “about” pages available in Firefox. Many exist to serve
as diagnostic tools. Others, like about:robots and about:mozilla, are just silly and
fun. To see all of the about pages, simply type about:about in the Firefox
address bar (which, coincidentally enough, is also called the “Awesome bar”).

Firefox Tips, Tricks & Easter Eggs
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Summary

Yes, I know that Firefox recently got into some
trouble with some users over their “virtue signaling.”
Mozilla … I hope you’re listening. You don’t have a
large enough of a browser market share to alienate
ANY users, first of all. And even if you did have a
majority browser market share, why would you want
to risk alienating any users? Secondly, why not just
remain apolitical and let the political hacks (it’s the
kindest term I could think to use) go about their
usual, corrupt, messed up ways of … well …
messing things up for the rest of us. They don’t need
your help. Stick to what you do best, which is
making the best damned browser EVER!

I hope these little tips, tricks and Easter eggs add to
your enjoyment of Firefox. I know that they do for
me.
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INGREDIENTS:

1 Tbsp. olive oil or butter
1 medium onion,sliced
1 lb. ground beef, grass fed if available
2 tsp. Worcestershire sauce
salt and pepper
3 Tbsp. queso melting cheese
8 slices thin-sliced bread

Comeback Sauce

2 Tbsp. mayonnaise
2 Tbsp. ketchup
1/2 Tbsp. dill pickle relish
dash Worcestershire sauce

DIRECTIONS:

To prepare Comeback Sauce:
Mix all ingredients well. Use this as a sandwich
spread with patty melts.

Heat oil or butter in a large skillet then add sliced
onion. Cook and stir until soft and golden brown-
about 15 minutes. Remove from the skillet and keep
warm.

Add worcestershire sauce to ground beef and form
into 4 thin patties. Sprinkle with salt and pepper as
desired. Place patties in the skillet and cook over
medium heat turning as needed until fully cooked.

Place onions on top of cooked patties, then pour
melted queso over all.

Toast bread slices. Spread 2 slices of toast with
comeback sauce then add a patty with onions and
cheese to form the sandwich.

TIP:

Substitute ground beef with ground turkey or ground
chicken.

Nutrition:

Calories: 346 Carbohydrates: 13g
Fiber: 2g Sodium: 390mg Fat: 22g

PCLinuxOS Recipe Corner Bonus

Low Carb Patty Melt
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 277, average score 194.
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ADMIRER ADORATION

AFFECTIONATE AMOROUS

ANGEL BALLOONS

BEAU BELOVED

BETROTHED BOUQUET

BOW AND ARROW BOYFRIEND

CHERISH CHERUB

CHOCOLATE COURTSHIP

CRAZY CRUSH

CUPID DARLING

DEVOTION DOVES

EMBRACE ENDEARMENT

FEBRUARY FIANCE

FRIENDSHIP GIRLFRIEND

GREETING CARD HEART

INFATUATION KISS

LOVE MOONSTRUCK

PASSION ROMANTIC

ROSE SECRET ADMIRER

SENTIMENTAL SMITTEN

VALENTINES DAY YEARNING
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1. Engaged.

2. A persistent, often melancholy desire.

3. The ancient Roman god of love.

4. Flower arrangement.

5. A man who is engaged to be married.

6. One who is greatly loved or adored.

7. Ardent, often selfless, affection and dedication.

8. A feeling of foolish or obsessively strong love

for someone.

9. Profound love or regard.

10. To treat with affection and tenderness.

11. A person, especially a child, with a sweet,

chubby, innocent face.

12. One who cares for another romantically, but

chooses to stay anonymous.

13. Having or showing an especially tender or

affectionate feeling.

14. Hug, clasp or hold close with the arms.

15. Dazed or distracted by romantic sentiment.
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